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Chapter 1 – Introduction 

The FaxFinder Fax Client Software lets you deal with faxes in a new and convenient way.  You can now 
send faxes simply by printing files from application programs (word processors, graphics programs, 
Notepad – essentially any program that can print).  You receive fax messages as graphics file 
attachments to email messages from the FaxFinder Administrator or Attendant.  You will view these 
graphics files (PDF or TIF) using either a PDF viewer or a TIFF viewer.  The PDF viewer could be any 
commercial viewer or any open source PDF viewer.  The FaxFinder is shipped with the Multi-Tech Tiff 
Viewer as part of the suite of FaxFinder client software.  Other TIFF viewers are available from many 
different sources. 

This arrangement lets you send and receive faxes at your own desk and deal with them entirely 
electronically if you so choose. 

Accessing the FaxFinder Client Software 

After the FaxFinder Fax Client Software has been installed, it will be on whenever your computer is 
running, unless you specifically turn it off.  An icon for the FaxFinder Fax Client Software will appear in 
the ‘tray’ area in the lower right corner of your computer screen.   

 

You must click on this icon and select “show FaxFinder Client Software” to make the program’s main 
screen visible.  You can also start the FaxFinder client software from the Start | Programs menu. 

Main Screen of FaxFinder Fax Client Software 

 

However, you can send and receive faxes without viewing the main screen. 
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Sending Faxes 

To send a fax from an application program, you must change that application program’s target printer to 
“Multi-Tech FaxFinder” (this option becomes available as soon as the FaxFinder client software is 
installed on your PC).  Then, when you invoke the Print command from your application software, the 
document will be effectively scanned or “captured” electronically in preparation for going out as a fax -- 
instead of being printed on paper.  Shortly after you invoke the Print command, the FaxFinder Send Fax 
screen will appear.  That’s where you specify the recipient(s) of the fax message. 

 

The FaxFinder Send Fax screen also lets you add common items to the fax message:  a cover page, a 
brief comment, etc.  The FaxFinder Fax Client Software also includes an Address Book in which you can 
store information about parties to whom you may regularly send faxes.  The FaxFinder Send Fax screen 
gives you access to the Address Book so that all of the recipient’s contact information (company name, 
street address, voice phone number, etc.) can be added automatically. 
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Receiving Faxes 

To receive a fax from the FaxFinder system, you simply open the email message received from the 
FaxFinder Administrator or forwarded from a party who serves as a “FaxFinder Attendant” for your 
network.  The way you receive fax emails (either directly from the Administrator or as forwarded from the 
Attendant) depends on the kind of phone service you have (whether through a PBX or not and depending 
also on PBX features).  The fax email you receive will open either into the PDF viewer program, the Multi-
Tech Tiff Viewer, or another TIF-viewing program that you specify.  You can then view the fax message, 
print it, save it, forward it , etc., as needed.  (Only TIF files can be forwarded; PDF files cannot be 
forwarded through the FaxFinder system.) 

These are the basics about FaxFinder.  The FaxFinder Fax Client Software has many capabilities.  This 
manual describes them and shows examples of how they work.  You will find sections on most common 
operations in the table of contents.  We also present detailed descriptions of each software screen. 

The FaxFinder is really pretty easy to use.  We hope you enjoy it.  If you have problems, call our Tech 
Support Department at 1-800-972-2439. 

Related Manuals 

The FF-120/220/420/820 FaxFinder hardware unit comes with 4 manuals that serve different purposes. A 
fifth reference manual is available on the Multi-Tech web site. 

Title Format Purpose 
Administrator User Guide 
 

on CD Presents comprehensive info about FaxFinder 
unit, server software, & client software. 

Client User Guide 
   (this manual) 

on CD Comprehensive user info for FaxFinder clients. 

Client Operation Primer on CD Brief instructions for sending and receiving 
faxes via the FaxFinder system.  Multi-Tech 
recommends that you print out a copy of this 
document for each user. 

Cabling Guide in print FaxFinder Administrator should use this 
manual to make cabling connections for the 
FaxFinder unit. 

FaxFinder Reference Guide 
(IP Office PBX Interface) 

on MTS 
web site 

FaxFinder Administrator should use this 
manual to configure the FaxFinder unit in 
conjunction with the Avaya IP Office PBX.   

 
Client users of the FaxFinder system should expect to receive electronic files of the Client User Guide 
and the Client Operation Primer from the FaxFinder administrator.  Print out these manuals in whole or in 
part as needed. 
Multi-Tech manuals and other resources are available on the Multi-Tech Web page at 
http://www.multitech.com. 
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Chapter 2 – FaxFinder Client 
Software Configuration 

To configure the FaxFinder Client Software, you must first install the software on a PC and then associate 
that installed client software with one or more specific FaxFinder hardware units. 

Installing FaxFinder Client Software 

A. Insert the FaxFinder Product CD into the CD-ROM drive of the client PC. If the CD does not auto 
start, use Windows Explorer to navigate to your CD drive and launch the installation program by 
double-clicking on cd_start.exe file on the CD. From the menu presented, click the Software button. 

 From the new screen presented, select the Client Software button to install the Multi-Tech FaxFinder 
Client software for using the FaxFinder unit. 

Important: Should you have any old versions of the FaxFinder client software installed, please uninstall 
that prior to installing the new version. For your convenience, there is a mass uninstaller available for 
push uninstalls on the product CD. It is in the Software folder and is called 
‘Remove_InstallShield_FFClient.msi’. 
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Chapter 2: FaxFinder Client Software Configuration 

 
 
B. At the Welcome screen, click Next. 

 
C. At the Select Installation Folder screen, browse to the desired file location for the FaxFinder client 

software.  In most cases, the default file location is recommended. 

 
Clicking on the Disk Cost button will show you the size of the software being installed as well as the 
available disk space of the target drive. 

When the destination location is correct, click Next. 
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D. At the Confirm Installation screen, click Next to begin the installation.. 

 
E. A transient screen will appear while files are being copied. 

 
F. You will be asked whether or not you want to associate .tif and .cpg files with the Multi-Tech Tiff 

Viewer. Click Yes (unless you prefer to use a different viewer program). 

If a Question screen appears asking "Warning - the extension .tif is already registered, Overwrite?,” 
you must respond. Click Yes if you wish to use the TIFF viewer installed with the FaxFinder Client 
Software. Click No if you prefer to use a different software package for viewing .tif files. 
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G. You will be asked if you want the Client software to automatically launch when the installation is 

complete. Select your preference. 

 
H. Then the Installation Complete screen will appear.   

 
 

Click Close. 
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The FaxFinder Fax Client Software starts automatically when the installation is complete. 
 
Icons for the FaxFinder software applications will appear in the Windows Start menu.  After installation, 
the Client Software starts up whenever the computer is booted. A FaxFinder icon appears in the tray area 
at the lower-right corner of the screen.  The FaxFinder Fax Client Software screen can be opened from 
either the Start menu icon or the tray icon.  (If the Client Software is shut down, it can be re-opened from 
the Start menu or by double-clicking on the FF110.EXE file, which, following a typical, default installation, 
would be located at C:\Program Files \ Multi-Tech Systems\FaxFinder Client Software\.) 

 
The FaxFinder Fax Client Software starts automatically when the installation is complete. 
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Establishing Client User’s ID in System 

When the FaxFinder Fax Client Software starts, you will be prompted to enter your own client user 
information in the Options | Identification screen.  You will not be able to access or use the FaxFinder 
client until this step has been done.   

 
The default value for the Options | Identification “Fax Header Local ID” field is the value taken from the 
“Fax ID” field (from the FaxFinder Server Modem Configuration screen) for the modem used in the fax 
transmission.   
 
Icons for the FaxFinder software applications will appear in the Windows Start menu.  After installation, 
the Client Software starts up whenever the computer is booted. A FaxFinder icon appears in the tray area 
at the lower-right corner of the screen.  The FaxFinder Fax Client Software screen can be opened from 
either the Start menu icon or the tray icon.  (If the Client Software is shut down, it can be re-opened from 
the Start menu or by double-clicking on a file named FF110.EXE (or something very similar), which, 
following a typical, default installation, would be located at C:\Program Files \ Multi-Tech 
Systems\FaxFinder Client Software\.) 
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Associating Client with Specific FaxFinder Unit(s) 

Sometimes more than one FaxFinder unit is connected to an Ethernet network.  In some cases, certain 
client users might be assigned to some FaxFinder units and not assigned to others.  After the FaxFinder 
client software is installed, you must associate it with one or more FaxFinder units.  This procedure shows 
you how to make this association so that faxes may be sent from a particular FaxFinder unit to the email 
inbox of your PC.  To do this procedure, you will need to know the IP address of the FaxFinder unit.  Be 
aware that an individual FaxFinder client user can be associated with more than one FaxFinder unit.  This 
could easily be the case in an office that is large and/or an office that has a great deal of fax traffic.  

1.  At the main screen of the FaxFinder Fax Client Software, click on Edit and select “Add Fax Server.” 

 
2.  At the Add Device Address screen, in the “Select Server” field, highlight “FaxFinder.” 

In the “Enter Address” field, enter the IP address or domain name of the FaxFinder unit that the client 
will use. 

A client can be associated with more than one FaxFinder unit, but the associations must be 
established one at a time. 

 
3. Enter, in the appropriate fields, the Username and Password that the client will use when accessing 

this FaxFinder unit.  If the client is to be associated with multiple FaxFinder units, a different 
Username and Password could be established for each.  However, in most cases, it is advisable (for 

Multi-Tech Systems, Inc. FaxFinder Client User Guide 13 
Download from Www.Somanuals.com. All Manuals Search And Download.



Chapter 2: FaxFinder Client Software Configuration 

the sake of simplicity and convenience) to use the same Username and Password for all FaxFinder 
units.   

NOTE:  The Username entered here must match the entry used in the “User ID” field of the Phone 
Book screen in the FaxFinder Server Software.  The password entered here must match 
the password entered for this client in the Password Administration screen in the 
FaxFinder Server software. 

Click OK. 

4. A new FaxFinder entry should appear on the “Device Status” tab of the FaxFinder Fax Client 
Software screen.   

 
The status of the newly registered FaxFinder unit should momentarily go from “Logging in” to “Idle.”   
If it goes to Login Failure, then one of two things is wrong: 

a. The IP address or domain name is wrong. If that is the case, delete that entry (by right-clicking 
DELETE), and enter a new one; otherwise, 

b. The Username/Password combination may be wrong.  Verify that the client Username/Password 
combination (accessible by right-clicking and selecting Properties on the FaxFinder listed in the 
Device Status tab of the client software) matches the User ID/Password combination assigned to 
the client-user by the FaxFinder Administrator. 
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Disassociating the Client from a Specific FaxFinder Unit 

In this procedure, you will un-do the procedure “Associating Client with a Specific FaxFinder Unit.”  This 
situation might occur when changes are being made in the network faxing system.  In any event, this 
procedure severs the tie between your PC and a specific FaxFinder unit so that you will no longer be 
connected to it for sending fax messages. (Faxes can be received in email form from the FaxFinder 
server, despite disassociating from the FaxFinder server, as long as the receiving party is entered in the 
FaxFinder Phone Book.)  In cases where the client is currently associated with more than one FaxFinder 
unit, you will need to know the IP address of the specific FaxFinder unit from which you want to 
disconnect. 

1. Open the FaxFinder Client Software program and go to the Device Status tab.  Select the FaxFinder 
unit from which you want to disconnect (you can identify the FaxFinder unit by its IP address or 
domain name).  Right-click on it and select delete. 

 
2. Your FaxFinder Client Software will no longer be able to send faxes through this particular FaxFinder 

unit. 
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Disabling and Re-Enabling a Client’s FaxFinder Service 

Disabling a FaxFinder’s service to a specific client is simply a temporary version of disassociating the 
client from that FaxFinder.  When a client has disabled the FaxFinder’s service to that client, the 
client/user cannot send faxes through the FaxFinder.  (Faxes can be received in email form from the 
FaxFinder server, despite this disabling, as long as the receiving party is entered in the FaxFinder 
Phone Book.)  The client can easily re-establish FaxFinder service by toggling the Disable command 
(now shown with a “ ” beside it), thus enabling service once again. 

1. Open the FaxFinder Client Software program and go to the Device Status tab.  Select the FaxFinder 
unit from which you want to disconnect temporarily (you can identify the FaxFinder unit by its IP 
address or domain name). Right-click on it and select disable. 

 
2. When disabled, a check mark will appear beside the disable command. 

3. To re-enable the FaxFinder unit for your use, that is to avail your PC of its service once again, open 
the FaxFinder Client Software program and go to the Device Status tab.  Select the FaxFinder unit to 
which you want to re-connect.  Right-click on it and select   disable.  You will now be re-connected to 
service by this FaxFinder unit. 

Sending Test Fax 

To verify that the software installation has succeeded, you should use the FaxFinder client software to 
send a fax to a regular fax machine (preferably a local fax machine).  To do so, follow the instructions for 
the “Sending a Fax” procedure in Chapter 3.  
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FaxFinder Fax Client Software Menu Command 
Definitions 

 
 

FaxFinder Fax Client Software Menu Command Definitions 
Command Name Values Description 

File menu commands  
Send Fax -- Brings up the FaxFinder Send Fax screen, the 

first step in transmitting a fax message via the 
FaxFinder system. 

Pause Scheduler -- When you invoke the Pause Scheduler 
command, any faxes currently pending will not 
be sent and any fax transmissions attempted 
while this command is in force will not be sent.   
When the scheduler has been paused, you must 
select   Pause Scheduler to rescind the 
command. That is to say, this command toggles 
on and off when selected repeatedly. 
If the computer is rebooted, the FaxFinder Fax 
Client Software will cancel the Pause Scheduler 
command at startup.  Any faxes that had been 
paused and left unsent when the computer was 
turned off will be sent immediately when the 
computer is turned on again. 
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The FaxFinder Send Fax Screen 

 
 
The FaxFinder Send Fax screen appears (a) when you ‘print to FaxFinder’ from any application program, 
or (b) when you select the Send Fax command from the File menu of the FaxFinder Fax Client Software 
screen. 
 

FaxFinder Send Fax Screen Definitions 
Command/Field Name Values Description 

Recipients pane  
Name (column) alphanumeric Party to whom the fax will be sent.  You cannot 

type in this window.  When a recipient is 
specified either from the Address Book or from 
the Enter a Fax Recipient window, that 
recipient’s name will appear in this field. 

Fax Number (column) numeric Fax number to which the fax will be sent.  You 
cannot type in this window.  When a fax number 
is specified either from the Address Book or 
from the Enter a Fax Recipient window, that fax 
number will appear in this field. 
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FaxFinder Send Fax Screen Definitions (cont’d) 

Command/Field Name Values Description 

Recipients pane  
+ (button) 

 

Brings up the Enter a Fax Recipient window.  At this 
window, you enter the name and fax number of the party 
to whom the fax will be sent.  After you click OK in this 
window, the FaxFinder-Add Recipient window will 
appear and prompt you as to whether or not you want to 
add this recipient to the Address Book. If you check the 
Remember this response box, the response you select 
will be remembered.  In other words, if you check 
Remember this response, and click the No button, 
recipients added using the + button on the Send Fax 
Form will never be automatically added to the Address 
book.  If you check Remember this response, and click 
the Yes button, recipients added using the + button on the 
Send Fax Form will always be automatically added to the 
Address book. 

- (button) -- Removes a selected entry from the Recipients list.  You 
will be prompted (by the FaxFinder – Delete? screen) to 
confirm removal of the recipient from the list of recipients. 

Address Book (button) -- Brings up the Address Book screen from which a fax 
recipient can be chosen. 

Documents pane  
Document (column) entries are 

alphanumeric 
with file-type 
extensions 

File name of document to be transmitted as a fax. 

Pages (column) entries are 
numeric 

Length (number of pages) of the fax to be transmitted. 

+ (button) -- Click this button to add another document to the fax 
transmission. Only TIFF files can be added with this. 

- (button) -- Click this button to remove a document from the list of 
items to be faxed.  You will be prompted (by the 
FaxFinder – Delete? screen) to confirm removal of the 
item from the fax queue. 

Λ (button) -- Clicking this button moves a selected document upward in 
the queue.  For example, if the file jonesbill.tif is third in 
the Document list, clicking  will cause it to be the second 
item faxed. 

V (button) -- Clicking this button moves a selected document 
downward in the queue.  For example, if the file 
jonesbill.tif is fourth in the Document list, clicking  will 
cause it to be the fifth item faxed. 

Schedule pane  
Send field “immediately” 

-or- 
at designated 

later time 

This field specifies when a fax will be sent.  By default, the 
fax will be sent immediately.  If you click the Schedule 
button and re-schedule the transmission, the time and 
date of the forthcoming transmission will be listed.  

Schedule (button) -- Click here to schedule a fax for transmission at a later 
time.  This button brings up the Fax Scheduling screen.  
See the procedure “Scheduling Fax Transmissions” in 
Chapter 6. 
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FaxFinder Send Fax Screen Definitions (cont’d) 

Command/Field Name Values Description 
Cover Page pane  

Use Cover Page Y/N Check this checkbox to include a cover page with 
your fax. 

Cover Page Style BoldComplete, 
BoldComplete2, 
FaxComplete, 

LongComment, 
PlainComplete, 

PlainShort 

If you have checked Use Cover Page, you can 
select a cover page style for your fax from this 
drop-down menu.  Six standard cover page 
styles are standard.  You can revise any one of 
these or create a new cover page style using the 
Template Editor program. 

View/Edit (button) -- Brings up the cover page Template Editor 
program where the chosen cover page template 
can be seen and/or altered. 

Subject alphanumeric Here you can type a brief description of the 
contents of the fax.  The placement of this 
“Subject” description will depend on the cover 
page style that you use. 

Cover Page Notes alphanumeric Here you can type a lengthy comment about the 
fax or related topics. 

Send Fax (button) -- Click here to invoke the sending of the fax. 
Preview Fax (button) -- Click here to see a preview of the fax, including 

the cover page.  This preview will appear in the 
TIFF viewer. 

Cancel (button) -- Click here to cancel the sending of the fax. 
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FaxFinder Fax Client Software Menu Command Definitions 

Option tab Description 

 

 

 

 

 
Identification tab.  The Fax Header Local ID can be used 
to set the ID of the Sending Modem when Sending a Fax 
using the FaxFinder Client. The Modem ID string is 
displayed in the header information of a sent fax. For many 
Fax machines, it is the phone number of the sending fax 
machine. The default is the Modem Fax ID which is set via 
Modem Configuration in the FaxFinder Server web 
interface. Phone Number will use the Identification Tab's 
Phone number field as the Modem ID string. Fax Number 
will use the Identification Tab's Fax number field as the 
Modem ID string. 
 
Fax Retry tab.  Here the client user can specify, for faxes 
that were not sent successfully on the first attempt, the 
number of subsequent attempts to be made, the interval 
between these attempts, when attempts should expire. 
 
Date/Time tab.  Here you enter the date and time formats 
for the fax header.   
 
Server Priority tab.  Here you choose to which fax server 
a sent fax would first be directed: to a FaxFinder, to a 
Hylafax, or to the first available.  This applies only to 
special multiple-modem server systems that use both 
FaxFinder and Hylafax. 
 
Advanced tab.  Here you designate the circumstances 
that will make the Send Fax window become minimized 
and allow the enabling of the synchronization of the 
FaxFinder Address Book with a Microsoft Outlook address 
book. Trace Outlook Sync should only be selected when 
directed by Multi-Tech Support as it generates a large 
amount of logging information and should not be left on for 
extended periods of time. It will generate a debug log that 
can be be used to debug problems syncing address book 
entries with Outlook. 
 
Logging tab.  Select Save Log on Exit to ensure the Log 
file exists after the application is closed. 
A Trace Level of 9 is the highest trace setting. A Trace 
Level of 1 is the lowest (least amount of trace) setting. 
Select Custom Log File to create a log file other than the 
default. You may Browse to an existing File Folder and 
type in the name of the custom log file in the edit field. 
Click Defaults to restore the Logging information to factory 
defaults. 
Click View Log to view the existing log file. 
Click Explore to start an explorer window to find existing 
log files. 
Click Delete Log to erase the current log. 
Click Delete All Logs to remove any previously existing 
Log Files. 
Click OK to save your changes. 
Click Cancel to Cancel any changes made. 
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FaxFinder Fax Client Software Menu Command Definitions (cont’d) 
Command Name Values Description 

Edit menu commands  
Add Fax Server -- Brings up the Add Device Address screen so 

that a FaxFinder or HylaFax server on the 
network can be associated with the client.  A 
client can be served by more than one FaxFinder 
unit.  See the procedure “Associating Client with 
Specific FaxFinder Unit(s)” earlier in this chapter. 

Add Contact -- Brings up the New Contact screen so that an 
recipient can be added to the Address Book.  
Once a recipient’s contact info has been entered 
into the Address Book, faxes sent to that party 
will have the destination fax number 
automatically conveyed to the FaxFinder unit.  
Info from recipient’s Address Book entry will also 
be included in automated fields on fax cover 
pages where applicable (for example, the voice 
phone number, company name, and city of the 
recipient might be two fields included on the 
cover page). See the procedure “Setting Up Your 
Address Book Manually” in Chapter 6. 

Edit Cover Page 
Template 

-- Brings up the Cover Page Generator (or 
Template Editor) program so that fax cover 
pages can be created or modified.  See the 
procedure “Creating or Modifying Cover Page 
Styles” in Chapter 6. 

Help menu commands Online Help is not currently supported.  See User 
Guides for detailed instructions.  An “About” 
command brings up the FaxFinder Fax Client 
About screen, which identifies the software’s 
version. 
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FaxFinder Fax Client Software Menu Command Definitions (cont’d) 
Field Name Values Description 

Device Status tab  
Device (column) alphanumeric Shows status of FaxFinder or HylaFAX server 

units with which the client is associated.  Also 
shows status of the “Print Capture” function and 
the “Outlook Synchronizer” function.  

Status (column) idle, negotiating, 
preparing to 
capture, capturing 
page n, sending 
fax page n, 
receiving fax page 
n, success, 
unsuccessful- user 
aborted, 
unsuccessful-no 
carrier, 
unsuccessful- no 
dial tone, 
unsuccessful-error 
<descriptor> 

Shows the status of the FaxFinder or HylaFAX 
fax server unit pertaining to its fax sending and 
receiving capabilities and to its print/image 
capturing capabilities. 

Recipient (column) alphanumeric Shows the name and fax number of recipient to 
whom fax is currently being sent. 

Print Capture (row) idle,  
preparing to 
capture,  
capturing page n 

Indicates status of the FaxFinder’s Print 
Capturing software module. 
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FaxFinder Fax Client Software Menu Command Definitions (cont’d) 

Command Name Description 
Device Status tab (cont’d) 

Commands accessed by Right-Clicking on a selected FaxFinder 
delete Dis-associates the client from the selected FaxFinder or HylaFAX unit so that 

the client can no longer send faxes through that FaxFinder unit. (The 
FaxFinder Server’s IP address is removed from the Device Status list of the 
FaxFinder Client Software.) 

disable Temporarily dis-associates the client from the selected FaxFinder or HylaFAX 
unit so that the client can no longer send faxes through that unit. 
To restore the connection to the FaxFinder/HylaFAX unit, select   Disable. 
(Because the FaxFinder Server’s IP address remains in Device Status list of 
the FaxFinder Client Software, service can be restored by toggling the Disable 
command, thus enabling the association once again.) 

abort Discontinues a fax transmission in progress. 
abort and Pause Discontinues a fax transmission in progress and puts all pending faxes on 

hold.  After this command has been invoked, no more faxes will be sent from 
this client until  
(a) the client PC is turned off and on again, or  
(b) the command has been turned off by selecting   Pause Scheduler in the 
File menu of the FaxFinder Fax Client Software.  

properties Brings up the FaxFinder <IP address><domain name> screen.  This screen 
simply shows the IP address or domain name of the selected FaxFinder unit. 

 

 

FaxFinder Fax Client Software Menu Command Definitions (cont’d) 
Field/Command Name Values Description 

Pending Faxes tab  
Recipient (column) -- Identifies recipient of each fax for which transmission is 

incomplete.   
Scheduled Time/Date -- Identifies time at which a pending fax is set to be 

transmitted.   
Pages (column) -- Shows the number of pages of each fax. 
Commands accessed by right-clicking on a selected pending fax message 
delete Cancels the transmission of the selected pending fax message. 
reschedule Brings up the Fax Scheduling screen so that transmission of a pending 

fax can be scheduled for a different time. 
properties Brings up the Fax Details screen for the selected pending fax .  The 

Fax Details screen presents information about the recipient, 
transmission status, cover page, and original source file of the 
selected pending fax.   

Multi-Tech Systems, Inc. FaxFinder Client User Guide 24 
Download from Www.Somanuals.com. All Manuals Search And Download.



Chapter 2: FaxFinder Client Software Configuration 

 

 
 

FaxFinder Fax Client Software Menu Command Definitions (cont’d) 
Field Name Values Description 

Fax Ports tab  
Device (column) alphanumeric Shows FaxFinder units with which the client is 

associated.   
Port (column) ttys0 for FF120, 

ttys0, ttys1 
 for FF220 
 
ttys_0-3 for FF420
 
ttys_0-7 for FF820 

The fax modem (within) the FaxFinder server 
unit, the status of which is being tracked.   
ttys0 denotes POTS Modem 1 of the listed 
faxfinder unit; 
ttys1 denotes POTS Modem 2 of the listed 
faxfinder unit, etc., for all modems in the FF-
420/820 unit. 

Status (column) idle, negotiating, 
preparing to 
capture, capturing 
page n, sending 
fax page n, 
receiving fax page 
n, success, 
unsuccessful- user 
aborted, 
unsuccessful-no 
carrier, 
unsuccessful- no 
dial tone, 
unsuccessful-error 
<descriptor> 

Shows the status of the FaxFinder fax server unit 
pertaining to its fax sending and receiving 
capabilities and to its print/image capturing 
capabilities. 

Recipient (column) alphanumeric Shows the name and fax number of recipient to 
whom fax is currently being sent. 

List All Fax Ports  Y/N When selected, all fax ports are listed; when not 
selected, only the current active fax port is listed. 
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FaxFinder Fax Client Software Menu Command Definitions (cont’d) 
Field/Command Name Values Description 

Fax Log tab  
Recipient (column)  Identifies recipient of each outgoing fax. 
Time/Date Sent (column) day, date, time, zone

in the form 
ddd mmm nn 
hh:mm:ss zzzzzz

Indicates when each outgoing fax was sent. 

Pages (column) integer Shows the number of pages in each fax. 
Status (column) success, 

unsuccessful- user 
aborted, 
unsuccessful-no 
carrier, 
unsuccessful- no 
dial tone, 
unsuccessful-error 
<descriptor> 

Indicates whether each fax was sent successfully 
or not and, if not, indicates reason for failure. 

Commands accessed by right-clicking on a selected fax log entry 
delete Cancels the selected fax log entry. 
resend Resends the selected fax.  The Fax Scheduling screen will appear to 

set a time for the resending to occur. 
properties Brings up the Fax Details screen for the selected fax.  The Fax Details 

screen presents information about the recipient, transmission status, 
cover page, and original source file of the selected pending fax. 
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FaxFinder Fax Client Software Menu Command Definitions (cont’d) 
Field/Command Name Values Description 

Address Book tab  
Name (column) alphanumeric Shows the name of the the selected Address 

Book entry. 
Organization (column) alphanumeric  Shows the organizational affiliation of the the 

selected Address Book entry. 
Fax Number (column) integers Shows the fax number of the selected Address 

Book entry. 
Commands accessed by right-clicking on a selected address book entry 
delete Removes the selected entry from the Address Book.  A confirmation 

screen appears before the deletion is executed.  
properties Brings up the Contact <name> screen screen for the selected 

address book entry.  The Contact screen shows user contact details 
(name, company name, fax number, phone numbers, and street 
address info). 
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FaxFinder Fax Client Software Menu Command Definitions 
Command Name Values Description 

Address Book menu commands  
Add Contact -- Brings up the New Contact screen for adding entries 

to client-user’s personal address book.  These entries 
are for parties to whom the client-user may want to 
send faxes.  The contact info includes the party’s 
name, their organizational affiliation, phone numbers, 
fax numbers, and land address information.   
The contact information goes into these specific fields: 
Name, Organization, Home Number, Work Number, 
Fax Number, Address, City, State/Province, and 
Postal Code.  
 
The New Contact screen allows for manual entry of 
contacts into the Address Book.  It can also be 
accessed from the FaxFinder Send Fax screen and 
from Edit | Add Contact.  

 

Import -- Brings up the Address Book Import screen.  The 
Import command allows you to import entries into your 
address book from a delimited file (e.g., a MS Outlook 
address book exported as a delimited file;  the 
delimiter could be a comma, semicolon, colon, or a 
tab).  In most cases, a template file is required to map 
the information from the import file into the appropriate 
fields of the FaxFinder Address Book (i.e., into the 
fields of the New Contact screen).   
The FaxFinder Client software includes a template that 
allows entries from one FaxFinder client-user’s 
Address Book to be imported into the Address Book of 
another client user. 
Template files are accessible by clicking on the 
“Browse” button in the “CSV import field mapping 
template” area of the Address Book Import screen. 

 

 
 

Export  Allows you to create a delimited file from the 
FaxFinder Address Book for use in applications 
that can import delimited files.  The delimiters 
could be comma, semicolon, colon, or tab.  The 
primary use of the Export command is to allow 
an established FaxFinder Address Book to be 
shared with other client users.  Export files have 
a .csv extension.  
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Chapter 3: FaxFinder Client Software 
Operation 

Introduction 

This chapter describes the things that a client user can do with the FaxFinder system.  Three software 
programs are involved: the FaxFinder Client Software, the Multi-Tech Tiff Viewer (or designated PDF 
viewer), and the Multi-Tech Cover Page Generator.  The programs work together with the FaxFinder 
Client Software acting as the hub of activity.  The FaxFinder Client Software interfaces with the FaxFinder 
Server, has a user interface, and calls upon the Cover Page Generator and viewer program for their 
special functions.  When sending faxes, the FaxFinder Client Software calls up the Multi-Tech Cover 
Page generator if cover pages are requested.  When previewing outgoing faxes, the PC’s operating 
system calls up the designated TIFF viewer to display the outgoing fax.  When viewing received faxes, 
the PC’s operating system calls up the appropriate viewer (PDF or TIFF).  The choice of file types (PDF 
or TIFF) is made in the FaxFinder Server software.  Note that client users can choose to display either on 
the Multi-Tech TIFF viewer or on a different (non-Multi-Tech) TIFF viewing program (see Step 7 of 
“Installing FaxFinder Client Software” in Chapter 5).  Likewise, if the FaxFinder system distributes 
incoming faxes as PDF files, the client can designate which PDF viewer to use. 
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Sending a Fax 

To send a fax by printing from an application program on a client PC, follow the steps listed below. 

1. The FaxFinder client software must be installed on the PC. (See the section “Installing FaxFinder 
Client Software” earlier in this manual.) 

2. The client PC and the FaxFinder server must both be connected to the same Ethernet LAN system.  

3. The association must be made between the client PC and the FaxFinder Server. (See the section 
“Associating Client with Specific FaxFinder Unit(s)” earlier in this manual).   

4. After installation, the FaxFinder Fax Client Software program will be running whenever the PC is on. 
You can view the FaxFinder program's main window by clicking on the FaxFinder icon at the lower 
right of the PC’s monitor screen in its Application Tray. Then select “Show FaxFinder Client 
Software.”  

Note: The user can shut down the FaxFinder program by selecting "exit" either from the 
tray icon or from the main FaxFinder program screen.  If the program has been 
shut down, it can be restarted from the Windows Start menu.)  

 
 

 
However, you can send faxes through the FaxFinder without bringing up the FaxFinder Client 
Software screen. 
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5. At the application program (for example, a word processing program or drawing program), print to the 
FaxFinder. 

Setting the destination of the printing job varies from program to program.  For the common Notepad 
text editor program, for example, you must set the destination printer in the Page Setup screen.  In 
most cases, however, the destination printer can be set in a Print menu that appears when each 
printing job is initiated. 

 
Leave Properties/Preferences at Default Settings.  After the FaxFinder has been chosen as the 
target printer, a ‘Properties/Preferences’ screen can be accessed by clicking on either “Properties” 
or “Preferences” on the Print dialog box (for most application programs, it’s a “Properties” button; for 
a few, it’s a  “Preferences” button).  However, we strongly advise you not to change any 
parameters on the Device Settings tab or the Profile Manager tab of that screen.  If you have 
changed any parameters, click on the “Restore defaults” button to reset the parameters.   
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6. After the printing has been initiated by the application program, the FaxFinder Send Fax screen will 
appear.   

 
Click on Address Book.  When the Address Book screen appears, click “New.”  At the New 
Contact screen, enter the recipient’s name, fax number, and any other contact information you want 
to retain.   

The recipient’s fax number should be entered as you would dial it from a phone on the public phone 
network (as from a residential phone).  Click OK.  At the Address Book screen, highlight the 
recipient in the list and click “Select.”  The party will appear in the “Recipients” list in the FaxFinder 
Send Fax screen. 

Additional recipients can be added.  The same fax message will be sent to all recipients. 

Streamlined Approach.  You can also add a recipient in the FaxFinder Send Fax screen by clicking +  
to launch the Enter a Fax Recipient screen where you can enter Name and Fax Number only.  You 
can then choose to send the fax with or without adding the recipient to your Address Book.   
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You can also access the Address Book directly to add and edit entries.  At the FaxFinder Fax Client 
Software screen, go to Edit | Add Contact. 

7. If you want to include a cover page with your fax, click in the “Use Cover Page” checkbox.  Enter 
information as needed in the “Subject” and “Cover Page Notes” fields.   

Automated fields, like sender information (individual name, company name, street address, phone 
number, fax number, etc.) should be entered in the Address Book.  The Address Book is accessible 
in the “Options” menu of the FaxFinder Fax Client Software screen.  For more information about 
addresses and the automated fields used in cover pages, see the section “Setting Up Your Address 
Book” later in this chapter.  
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The “Cover Page Style” chosen will determine how this information will appear on the fax cover page.  
You can select a standard style from the “Cover Page Style” drop-down menu or create a style of 
your own in the Template Editor.  To access the Template Editor software, click on the “View/Edit” 
button.  (For more information, see the section “Creating or Modifying Cover Page Styles” later in this 
chapter.)   

Click on the “Preview Fax” button to check the fax before you send it. The Multi-Tech Tiff Viewer 
program will appear.   

 
In it, you can view both the cover page and the main fax page(s).  (For more information on this, see 
the section “Using the Multi-Tech Tiff Viewer” later in this chapter.)  When satisfied with your fax, 
close the viewer program and return to the FaxFinder Send Fax screen. 

8. At the FaxFinder Send Fax screen, click on the “Send Fax” button to send the fax. 

9. Confirmation of having sent the fax(es) successfully will appear in the “Fax Log” tab of the FaxFinder 
Fax Client Software screen. 
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Scheduling Fax Transmissions 

The FaxFinder allows you to send a fax immediately or delay its transmission until a later time.  Perhaps 
the most common motivations for delayed faxing are to enjoy the lower phone rates that may apply at 
night and on weekends or to broadcast faxes after business hours to avoid tying up fax transmission 
resources during the busiest weekday hours.  In any case, it is easy to schedule faxing for a later time. 

1. Send the fax via FaxFinder in the normal way (see the procedure “Sending a Fax” earlier in this 
chapter).   

2. When the FaxFinder Send Fax screen appears, enter a recipient for the fax either from the Address 
Book or by entering Name and Phone Number (fax number) in the appropriate fields and clicking Add 
Recipient. 

3. In the FaxFinder Send Fax screen, the recipient’s name and fax number will appear in the “Recipients” 
list and the “Schedule” pane will no longer be grayed out.  Click Schedule.  The Fax Scheduling 
screen will appear. 

 
4. Click to uncheck the “send immediately” checkbox. 

5. Enter the date and time at which you want the fax to be sent. 

6. Click OK in the Fax Scheduling screen and then click Send Fax in the FaxFinder Send Fax screen. 
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7. The fax will be sent at the scheduled time.  You can view the event as it happens in the FaxFinder 
client software Device Status screen or after the fact in the Fax Log screen. 

 
 

Re-Sending a Failed Fax 

Locate the failed fax in the Fax Log tab of the FaxFinder Fax Client Software.  Select the failed fax and 
right-click on it.  In the menu that appears, select Resend. 
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Putting Pending Faxes on Hold and Removing the Hold 

Suppose you have sent a fax to 10 recipients and, shortly after clicking on Send Fax, you realize that 
there is something incorrect in the content of your fax (it may be something you want to add, delete, or 
change). You can prevent any pending faxes from being sent by selecting “Pause Scheduler” in the File 
menu of the FaxFinder Fax Client screen.  Suppose that 2 faxes have already been transmitted 
completely and a third fax is in progress when you click “Pause Scheduler.”  The FaxFinder will finish the 
third fax but will not fax to recipients 4-10.  The pausing function allows you to see details about the fax, 
to view the fax again, and to delete the fax if you so desire.   

As long as “Pause Scheduler” is selected, no fax message will advance beyond “Pending” status and, so, 
none will be sent. 

To rescind or call off the hold on pending faxes, open the FaxFinder Fax Client Software.  From the File 
menu, select   Pause Scheduler.  The scheduler will resume normal operation and faxes will be sent. 

Consider this example.   

1. A fax is sent by FaxFinder to three recipients. 
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2. While the fax is being sent to the second party, the client user realizes that there is something wrong 
with the fax.  She brings up the FaxFinder Fax Client Software screen, opens the File menu, and 
selects “Pause Scheduler.”   

 
At that point, the FaxFinder will complete the fax in progress that is being sent to the second recipient. 
However, the fax to the third recipient is still listed as “Pending” in the Pending Faxes tab of the 
FaxFinder Fax Client Software. 

 
The client user can take one of several actions.   

She could click on “Pause Scheduler” again to cancel that command.  In that case, the pending fax 
would become active and could not be stopped. 

She could select the fax in the Pending Faxes screen and right-click on it to bring up a menu. 
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She could view the details of the fax and, at her option, view the fax again. 

 
She could re-schedule the fax for a later time. 
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She could “delete” the fax, which means that that fax transmission would never be completed. 

 
Pause is canceled on reboot.  If she shuts down her computer for the day while leaving this fax in a 
“pending” state, that fax will be sent shortly after booting up her computer again, that is shortly after the 
FaxFinder client software is functioning again.  So, any faxes put in the pending state by using the ‘Pause 
Scheduler’ command will be sent the next time the FaxFinder software is activated. 

Canceling a Fax 

If the fax is in progress …  Open the FaxFinder Fax Client Software.  On the Device Status tab, select 
the FaxFinder unit that is in the process of sending your fax.  In the list, right-click on that FaxFinder entry.  
In the menu that appears, select Abort. 

If the fax is pending …  Open the FaxFinder Fax Client Software.  On the Pending Faxes tab, select the 
fax transmission that you want to cancel.  In the list, right-click on that fax message entry (the recipient 
will be shown).  In the menu that appears, select Delete. 

To cancel the current fax and simultaneously put a hold on sending any other faxes from your PC, select 
Abort and Pause.  To resume faxing, go to the File menu and cancel the pause by selecting   
  Pause Scheduler.  Any pause applied to a pending fax is cancelled when the computer is rebooted.  
Any fax left pending with the FaxFinder Scheduler paused will be sent as soon as the FaxFinder client 
program opens when the PC is turned on again.   

Setting Fax Retry Number and Interval 

You can set the FaxFinder client software to retry a fax transmission if it fails on the first attempt.  You can 
set both the number of additional attempts and the interval between each additional attempt.  You can set 
these parameters as follows. 

1. In the FaxFinder Fax Client Software screen, open the File menu and select “Options.”  When the 
Options screen appears, click on the Fax Retry tab. 

 
2. Set the number of retries and the interval between these repeated attempts and click OK. 
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Sending One Fax Containing Multiple Documents 

The FaxFinder allows you to include multiple documents in a single fax transmission.  Those multiple 
documents could come from the same or different application programs.   

1. Consider the example below where a text file and a drawing file are included in the same fax with a 
single cover letter. Here’s how this multiple-document fax was sent.  

a. The user printed the text file to the FaxFinder from the Notepad text editor program. 

b. The FaxFinder Send Fax screen appeared.  However rather than completing the fax 
transmission, the user opened another application program. 

c. The user printed the graphic file to the FaxFinder from the Macromedia FreeHand drawing 
program.   

d. When the user returned to the FaxFinder Send Fax screen, both documents appeared in the 
“Documents” list. 

 

2. In the “Documents” pane of the FaxFinder Send Fax screen, you can add a cover page, re-arrange 
the order of the files, or delete items from the list of files to be faxed. 
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3. You can also add to the list of files to be faxed out by including items that you have stored.  In the 
“Documents” pane of the FaxFinder Send Fax screen, click +.  You could then browse to find, for 
example, a fax that you had received earlier, had stored as a TIF file, and now want to forward to 
another party.  (Faxes received as PDF files cannot be added to the list.) 

 

4. When all documents to be transmitted have been listed in the Documents list, click Send Fax.  The 
documents will be sent in the order listed. 
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Forwarding a Fax 

Suppose you receive a fax using the FaxFinder system.  Suppose that fax message is something you 
want to pass along to another party in fax form at a later date (for example, Rocky Mountain Construction 
Company receives tax information about lots on which it intends to build houses).  In this case, you 
should note the name of the TIF file in question.  You can then browse to that TIF file and re-send it as a 
fax message.  

Note: Forwarding of faxes applies only to TIF files; PDF files cannot be forwarded.   

To forward a fax, follow these steps. 

1. At the FaxFinder Fax Client Software screen, go to the File menu and select “Send Fax.”  The 
FaxFinder Send Fax screen will appear. 

2. In the Documents pane, click “+”.  Then browse to the TIF file to be sent as a fax.    

 
Click Open. 

3. The selected file will appear in the “Documents” list in the FaxFinder Send Fax screen.   
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4. In the FaxFinder Send Fax screen, specify a recipient for the fax.  The recipient could either come 
from your Address Book or be entered by clicking “+” in the “Recipients” pane and then typing the 
Name and Fax Number in the  Enter a Fax Recipient dialog box.  Then click OK.  

 

Finally, you would click Send Fax.  The TIF file will be reconverted into a fax message that can be 
received by a fax machine. 
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Receiving a Fax 

The FaxFinder Server delivers incoming faxes to client PCs in their email inboxes.  

Since faxes received through the FaxFinder are transformed into email attachments, they can be directed 
anywhere email goes.  The final recipient can be inside the office or across the ocean. 

Fax reception works differently when the FaxFinder is operating in Automated Routing Mode than in 
Manual Routing Mode.  In Automated Routing Mode, faxes come directly to client/users; in Manual 
Routing Mode, all faxes come to an attendant who forwards them to the intended recipient. 

Receiving Faxes in Manual Routing Mode 
In Manual Routing Mode, all faxes are emailed to an attendant using a single fax number.   

1. The incoming fax arrives in the attendant’s email inbox as a message with an attachment.   

2. The attendant uses email to forward the message to the appropriate recipient.  Recipients could be on 
the local Ethernet network or outside of it.   

3. The recipient opens the email message.  The incoming fax message takes the form of a graphic file 
attachment.  The FaxFinder Server has assigned the file an automatic file name. 
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4. The incoming fax arrives in the client’s email inbox as a message with an attachment. 

The email message is marked as being from the FaxFinder Administrator. 

The sender’s “Remote ID” and the client’s name appear in the “Subject” line of the email message.  
(The Remote ID comes from the sending fax machine and is typically the sender’s fax number or 
name.)  
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5. The FaxFinder client opens the email message.  The incoming fax message takes the form of a 
graphic file attachment.  The FaxFinder Server has assigned the file an automatic file name. 

 
6. The FaxFinder client can open the file or save the file. 

a. Opening the fax message graphic file.  Incoming fax messages are PDF or TIFF files.  These 
graphics files are automatically associated with a PDF or TIFF viewer program that has already been 
chosen.  The client can open the fax email attachment directly in the viewer program. 

b. Saving the fax message graphic file.  In some viewer programs, the client can do a ‘Save As,’ 
renaming the graphic file attachment with a meaningful name for subsequent viewing or for 
forwarding (applicable to TIFF files only). 

7. The client views the fax message in the (PDF or TIFF) viewer program. 

Receiving Faxes in Automated Routing Mode 
In Automated Routing Mode, the FaxFinder Server delivers incoming faxes to client PCs in their email 
inboxes. 

1. A PBX extension number must be assigned to the client PC at the FaxFinder Server.   

2. For fax reception, the client PC and the FaxFinder server need not both be connected to the same 
Ethernet LAN system.  (A sales representative, for example, could receive faxes sent to her home 
office fax number even though she is traveling overseas, if she uses an Internet email account.)  

3. A fax document is sent to the PBX extension number of a client/recipient on the FaxFinder system.  
The fax call is routed to the FaxFinder server and there converted to a PDF or TIFF graphic file.  The 
graphic file is attached to an email message that is sent to the intended recipient’s email address (as 
specified in the FaxFinder Phone Book). 
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4. The incoming fax arrives in the recipient’s email inbox as a message with an attachment. 

The email message is marked as being from the FaxFinder Administrator. 

The sender’s “Remote ID” and the recipient’s name appear in the “Subject” line of the email 
message.  (The Remote ID comes from the sending fax machine and is typically the sender’s fax 
number or name.) 

 
5. The fax recipient (a client of the FaxFinder Server) opens the email message.  The incoming fax 

message takes the form of a graphic file attachment.  The FaxFinder Server has assigned the file an 
automatic file name. 

6. The FaxFinder client can open the file or save the file. 

a. Opening the fax message graphic file.  Incoming fax messages are PDF or TIFF files.  These 
graphics files are automatically associated with a PDF or TIFF viewer program that has already been 
chosen.  The client can open the fax email attachment directly in the viewer program. 

b. Saving the fax message graphic file.  In some viewer programs, the client can do a ‘Save As,’ 
renaming the graphic file attachment with a meaningful name for subsequent viewing or forwarding. 

7. The client views the fax message in the (PDF or TIFF) viewer program. 
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Using the Multi-Tech Tiff Viewer 

The Multi-Tech Tiff Viewer program has a variety of features that enhance the viewing of fax messages in 
graphic file form (thumbnails, zooming, spot magnification, scrolling, rotating, etc.).  The program can also 
manipulate and permanently alter the graphic files. 

Frequently Used Commands – Toolbar Icons 
The most commonly used functions are available as icons on the toolbar.  In the next three diagrams, we 
label and describe the functions of these icons.  
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While most of these features are common to many graphical programs, some warrant a bit of explanation. 

Copy.  The Copy function allows you to copy the fax file and insert it into a different application program.  
See “Importing Fax Images into Other Application Programs” below. 

Panning (Omni-Directional Scroll).  The “hand” icon allows you to bring any desired portion of the image 
into view. 

Zoom to Selection.  Click and drag with the mouse over the rectangular area you would like to view.  
The Multi-Tech Tiff Viewer zooms in sufficiently to fill the screen with the selected area. 
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Spot Magnifying Glass.  In this viewing mode, a magnifying glass icon (cursor) appears.   

 
It can be used in one of three ways to magnify any portion of the image: (a) Click over Area, (b) Click-and-
Hold Over Area, (c) Scan the Graphic. 

Click over Area.  A secondary window will appear that shows the ‘clicked-on’ area magnified.  You can 
adjust the size of the secondary window by dragging on its borders.  You can re-locate the secondary 
window by putting the cursor inside the window, clicking, holding, and dragging. 
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Click-and-Hold over Area. Two additional windows will appear.  The cursor itself becomes a small 
secondary window of fixed size.  The same image also appears on a third window. You can adjust the 
size of the secondary window by dragging on its borders.  You can re-locate the secondary window by 
putting the cursor inside the window, clicking and dragging.   

 
Scan the Graphic.  If you click, hold, and drag, you can scan the image in a magnified view.  Two 
magnifying windows will appear as in the “Click-and-Hold Over Area” description above. 
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Importing Fax Images into Other Application Programs 
The Copy command in the Multi-Tech Tiff viewer program allows you to import the fax image into other 
application programs.  In the illustration below, a fax has been Copied from the Multi-Tech Tiff viewer 
program and Pasted into a Microsoft Word document. 
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Setting up Your Address Book Manually 

The Address Book in the FaxFinder Client Software adds significant convenience to the system.  When 
recipient contact information has been entered in the Address Book, this information will appear 
automatically in the corresponding fields of the fax cover page. 

1. In the FaxFinder Fax Client Software screen, click on the “Address Book” tab. 

2. In the Edit menu, select “Add Contact.” 

3. In the appropriate fields of the New Contact screen, enter information about the fax recipient. 

 
 

4. After an entry has been made in the Address Book, you can view and revise it.  In the Address Book 
list, right-click on the name of the contact about whom you wish to review address information and 
select Properties. 

 

Multi-Tech Systems, Inc. FaxFinder Client User Guide 55 
Download from Www.Somanuals.com. All Manuals Search And Download.



Chapter 3: FaxFinder Client Software Operation 

5. A Contact – Recipient screen will appear presenting the contact info for this particular recipient. 

 
6. When you click on “Address Book” at the FaxFinder Send Fax screen, this same contact list will 

appear.   
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7. When you select an item from this list and select Use Cover Page, contact info will be added 
automatically to the appropriate fields of the cover page. 

 
8. To delete an entry from your Address Book, select the entry and right-click on it.  In the menu that 

appears, select delete.  In order to complete the deletion command, you must click “Yes” in the 
confirmation screen.  
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Setting Up Your Address Book by Synchronizing with 
Outlook 

What Synchronization Means 
During synchronization, entries from the FaxFinder Client Address Book and from the specified folder of 
MS Outlook are merged into one list saved in both applications.  When “Synchronize With Outlook” 
command is invoked in the FaxFinder Client software, each list is updated with changes from the other. 

Synchronization Procedure 
1. In Microsoft Outlook, view the folder from which you want to be able to transfer fax numbers to the 

FaxFinder Client Address Book.  Confirm that you want those entries in your FaxFinder Client 
Address Book. If so, proceed.  (For example, you might select the “Contacts” folder in Outlook as 
your source of existing fax numbers). 

2. In the FaxFinder Fax Client Software, go to File | Options |Advanced and click on “Enable Outlook 
Sync.”   

 
3. Click on Browse. Select the desired folder from the Select Contact Folder (Outlook:) screen.  Click 

OK.  If a confirmation screen appears, click OK. 

 
At the Options screen, click OK. 
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4. In the FaxFinder Fax Client Software, go to the Device Status tab and select Outlook Synchronizer 
in the “Device” list. 

5. Right-click on Outlook Synchronizer and select Synchronize with Outlook. 

 The attempt to synchronize the FaxFinder Address Book with MS Outlook will cause Outlook to 
present a security screen at which you must click the “Allow access for” checkbox and choose a  
<time period> from the drop-down menu.  For a large address book, five minutes should be adequate 
time for the synchronization to be completed.  Then click Yes.  

 
The Outlook Contact information will be copied into the FaxFinder Address Book.  Entries from the 
FaxFinder Address Book (if any) will also be copied into the Outlook Contact list.  A relationship will 
be created between the corresponding entries for future synchronizations. 

 The Outlook Synchronizer feature has many options.  For further details, see the Administrator User 
Guide.   
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Setting Up Address Books with CSV Files 

Files in CSV format (comma separated values) consist of spread-sheet data presented in ASCII (plain 
text) form.  As such, the data can be transferred between different application programs.  Many common 
programs (like MS Excel and MS Outlook) can do both importing and exporting of CSV files.   

The FaxFinder Client software can also do both importing and exporting of CSV files. 

Typically, the reason a FaxFinder client-user would export his/her FaxFinder Address Book into a CSV file 
format would be to share entries with another FaxFinder client-user.  A FaxFinder client-user might also 
import a CSV file from another application (for example, both MS Outlook and MS Excel files can be 
exported into CSV format) in order to expand his/her FaxFinder Address Book. 

To import a CSV file, a template file is needed to map the fields of the source file into the appropriate  
corresponding fields of the destination database.  For client-to-client imports, a standard template file is 
included with the FaxFinder client software making such imports very easy. There is, after all, a one-to-
one correspondence of the data fields. 

When importing to your FaxFinder Address Book from other sources, there generally will not be a one-to-
one correspondence between the data fields and so a customized template will be needed to map the 
data fields properly. 

Suppose you had a list of potential customers exported to CSV format from an MS Excel spreadsheet 
and, for each customer, there were 10 fields of data, including their names and fax numbers.  To import 
this information into the  FaxFinder Address Book (which has 9 fields of data in an established order), you 
would have to specify that each customer name  and fax number from this CSV file gets transferred into 
the Name and Fax Number fields of the FaxFinder Address Book.  Other fields from the customer list 
might fit into other FaxFinder Address Book fields, as well, but some fields may not fit.  
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To map the fields from the CSV file to the FaxFinder Address Book format, you create a custom template 
file using the FaxFinder’s Template Mapping screen.  
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Exporting a FaxFinder Address Book to CSV File Format   
1. At the FaxFinder Client software, go to Address Book | Export.  The Address Book Export screen 

will appear.   

 
2. Use the “Delimiter” drop-down list to choose the kind of character that will be used to separate the 

fields of information in the Address Book entries.   
 

 
 
3. Click Export. 
 
4. The Save Delimited Address Book screen will appear.  Save the CSV file with an appropriate 

filename.  
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Importing CSV Files into FaxFinder Address Book with Fitted Template 
1. In the FaxFinder Fax Client software, go to Address Book | Import.  The Address Book Import 

screen will appear. 

 
 
2. Under “CSV Import file,” click Browse.  A list of CSV files will appear.  Select the CSV file that you 

want to import.  (The CSV file will likely be a file outputted from MS Outlook or a file containing 
contacts from another client-user of the FaxFinder system.) 

 
3. A delimited file can be exported with or without a first row that defines the columns.  Check the First 

Line Headings checkbox if the import file has first line headings. 
 
4. In the Delimiter dropdown menu, choose the delimiter used in the CSV file (comma, semicolon, colon, 

or tab).  
 
5. Under CSV import field mapping template, click Browse.  Select the template file (the file extension is 

.yml) that is needed to map the entries of the CSV file into the fields of the FaxFinder’s New Contact 
screen.  (If the  CSV file is one that was exported from another FaxFinder client user, you will need the 
FaxFinder Client Import_template.yml template file.) 
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6. To find out whether or not the new entries are being properly placed into the Address Book format, 
click Preview Import.  The Template Mapping screen will appear.   

 

 
Use the Next Record and Previous Record buttons to page through the entries as they would appear 
if you proceed with importing.  If the entries are to your liking, click OK.   

 
If the entries are not properly organized, will may need to adjust your Delimiter and/or First Line 
Heading settings.  Or, you may need to modify the template (see “Importing CSV Files into FaxFinder 
Address Book with a Customized Template” later in this chapter). 
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For example, if the first record has a literal value of “Name” in the Name field, a literal value of 
“Organization” in the Organization field, etc., then your import CSV file did indeed have First Line 
Headings and you may have failed to check the “First Line Heading” check box.  To clean up your file 
import, you must correct this by checking the First Line Heading checkbox. 

 
Using Preview Import to Correct Import Problems 

Here the import file had included first-line 
headings but the First Line Headings checkbox 
was not checked.  The consequence of this 
mistake is to have a meaningless entry in your 
Address Book.  

Corrected File. 
After the First Line Headings checkbox has 
been checked, the meaningless entry is no 
longer present.   

  

 
If you attempt to import with the wrong delimiters (suppose the import CSV file is delimited by commas 
and you attempt to import it using semicolons as the delimiters), then an error message will appear.   

 

 
 
7. Click Import.  The importing activity will be indicated in the Device Status tab of the FaxFinder Fax 

Client Software screen. 
 

 
 
8. The new entries from the CSV file will now appear in your Address Book. 
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Importing CSV Files into FaxFinder Address Book with a Customized Template 
CSV contact lists can be created in many applications (MS Outlook, MS Excel, Notepad, etc.).  In general, 
those contact lists may contain information that does not fit directly into the format of the FaxFinder’s New 
Contact screen.   
 
Suppose a useful CSV file exists but its contents (data fields) are not in the same order as data in the 
New Contact screen.  Or suppose that useful CSV file contains extra information beyond the fields of the 
New Contact screen.  In such cases, you will have to create a template file (with file extension .yml) that 
properly maps the useful information from that CSV file into the format of the New Contact screen. 
 
1.  Consider a CSV file that has been exported from MS Excel. 

 
Compare the field structure of this file to that of the New Contact screen of the FaxFinder client Address 
Book. 

 

Because this CSV file contains extra fields (like “Position” and “Cell Phone”) that are not in the FaxFinder 
Address Book New Contact screen, a new template will need to be created to map its information into 
the FaxFinder Address Book. 
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2. In the FaxFinder Client software, go to Address Book | Import.  The Address Book Import screen will 
appear.  Browse to find the CSV file that you want to import. 

 
3. Click Define Template.  The Template Mapping screen will appear.  

The Imported Fields drop-down box presents a list of all of the fields present in the CSV file.     
 

 
4. Click on the Imported Fields drop-down box and select the field name from the CSV file that matches 

(or most closely matches) the name of the New Contact screen field into which that information will be 
placed.  

 
 
5. Then click + to map that selected field from the CSV file to the corresponding field in the New Contact 

screen. 
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6. When one field name from the drop-down list has been added (with the + button), the next CSV field 
name in the drop-down list will appear.  Click + on the next line to associate that CSV field with the 
next New Contact screen field (if the association makes sense).  Sometimes the field names will differ 
but it will be appropriate to map the CSV field to the New Contact screen field anyway. (For example, 
the “Company” field from the CSV file can logically be mapped to the “Organization” field of the New 
Contact screen.)   

 

 
7. When the field names from the CSV file cannot logically be mapped from the CSV file to the New 

Contact screen (for example, the “Position” field from the CSV file cannot be logically mapped to any 
New Contact screen fields), skip that CSV field.  

 

 

8. Search in the Imported Fields drop-down list for appropriate CSV fields and use the + button to map 
such CSV fields to New Contact screen fields as needed. 

 

 
 
9. Use the – button on any line to delete an unwanted mapping. 
 

10. The CSV file may have more or fewer fields than the New Contact screen.   
 

In any event, you must map a fax recipient Name and a Fax Number from the CSV file to the New 
Contact screen to create valid entries in the FaxFinder Address Book.   
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Finish mapping all appropriate CSV fields to New Contact screen fields.   
 

 
 

11. When the mapping is complete, click OK.  You will then be prompted to name the template file 
that you have just created to accommodate this CSV file.  
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12. The Address Book Import screen will return.  It will list both the CSV import file and the template file 
you have just created.   

 
13. To confirm that the field mapping is appropriate, click on Preview Import.  At this screen, you can 

view each entry before importing.  If the entries are correct, click OK to return to the Address Book 
Import screen.   

 
14. If the entries are not right, you can use the Modify Template command to revise the template as 

needed. 

15. When you are satisfied that the mapping is set up correctly, click Import at the Address Book Import 
screen.  The importing activity will be indicated in the Device Status tab of the FaxFinder Fax Client 
Software screen. 
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16. The new entries from the CSV file will now appear in your Address Book.   
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Transferring an Established Standard FaxFinder Address Book to a New Client-
User 
A FaxFinder Address Book can be created in any of several ways: new contacts can be added manually, 
they can be added when faxes are being sent, they can be added by synchronizing with Outlook, and 
they can be added by importing CSV files. 
 
In many cases, it will be desirable that all members of an organization have access to a ‘starter’ Address 
Book with a common/standard set of contact entries that might be useful to everyone in the organization.  
Thereafter, each individual client-user can modify his/her Address Book as needed. 
 
Therefore, it may be important to have an established ‘standard’ Address Book to furnish to a new client-
user.  To provide such a ‘standard’ starter Address Book for new client-users, follow the steps below. 
 
1. The FaxFinder Administrator (or other keeper of the standard Address Book) should export his/her 

Address Book with an appropriate file name.   
 

At the FaxFinder Client software, go to Address Book | Export.  Choose the required delimiter from 
the “Delimiter” drop-down list.  Then, at the Address Book Export screen, click Export. 

 

 

 
 

Save the CSV file with an appropriate filename. 
 
2. The FaxFinder Administrator should then send the standard Address Book CSV file to the new client-

user by email.  Include advice about whether or not First Line Headings are used in the standard 
Address Book. 

 
3. The new client-user must put the Standard Address Book CSV file into a convenient directory on 

his/her computer. 
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4. At the FaxFinder Client software, the new client-user should go to Address Book | Import.  At the 
Address Book Import screen, the client-user should browse to the established CSV import file at the 
top of the screen and browse to the standard client-to-client import template file in the lower part of the 
screen (the file name will be FaxFinder Client Import_template.yml or something similar and this file 
will be available as soon as the client software is installed). 

 
5. The new client-user should click Import.  The organization’s ‘standard’ Address Book will then be 

installed and available for use by the new client-user. 
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Using Stock Cover Pages 

Faxes are often accompanied by a cover page that specifies from whom it was sent, to whom it was sent, 
the date, and other details about the sending and receiving parties.  The FaxFinder system offers several 
ready-made (stock) cover pages that can be used for this purpose.  These stock cover pages can also be 
modified or customized to meet individual needs (see “Creating or Modifying Cover Page Styles” later in 
this chapter). 

In this section, we present an example of using a stock cover page. 

1. We will send the fax from the Windows Notepad program.  (In this program, one sets the printer by 
going to File | Page Setup | Printer | Properties | Name and, in the drop-down list, set “Multi-Tech 
FaxFinder” as the target printer, and click OK).   

 
2. In Notepad, we select Print to send the file as a fax via the FaxFinder. 
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3. When the FaxFinder Send Fax screen appears, it will list the document we want to fax in its 
“Documents” pane.  Next we must specify a recipient.   

The recipient could either be chosen from the Address Book (by clicking on the Address Book button) 
or specified directly by clicking on + in the Recipients pane and completing the Name and Fax Number 
fields.  

In this example, we will choose the recipient from the Address Book by highlighting the entry and 
clicking Select.  Note the detailed address information about the recipient that had been stored when 
this party was entered into the Address Book (you can view the details on any Address Book entry by 
clicking Edit from the Address Book screen).  Recipient contact info from the Address Book entry will 
appear later in the automated fields of the cover page.  Sender contact info from the Options menu will 
also appear on the cover page.  Which details are included in the cover page depends on the cover 
page style used.  The “fax stamp” at the top of each sheet of the fax (which includes sender, recipient, 
and time info) is inserted automatically based on information from the FaxFinder server software and 
from the recipient fax machine. 
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4. The FaxFinder Send Fax screen appears again but this time our recipient has been entered. 
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5. Since we intend to use a cover page, we click “Use Cover Page” and then select a stock cover page 
from the “Cover Page Style” drop-down list.  We can then type a subject for the fax message and type 
a cover page note, each in the appropriate fields. 

 
 

Suppose we choose the style called “BoldComplete.”  We can view it by clicking “View/Edit” on the 
FaxFinder Send Fax screen.  The requested file will appear in the Template Editor screen. 
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6. To see how the cover page appears after the sender and recipient information has been automatically 
inserted, click Preview Fax.  This is how the fax cover page will be sent. 

 
 

7. To send the fax, simply click Send Fax in the FaxFinder Send Fax screen. 
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Creating or Modifying Cover Page Styles 

The Multi-Tech Cover Page Generator program allows you either to produce custom cover pages or to 
use existing style templates. In this section, we will describe both processes, making a new template and 
customizing an existing stock cover page style template.  

Creating New Cover Page Templates 
1. Open the Cover Page Generator program.  Go to Start | Programs | FaxFinder Client Software | 

Cover Page Generator.  You can also open the Cover Page Generator program from the FaxFinder 
Fax Client Software program by opening the Edit menu and selecting “Edit Cover Page Template.” 

 
 

2. The main Template Editor screen will appear.  Open it to full-screen size. 
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3. Several types of objects can be added to a cover page file.  These are listed in the Insert dropdown 
menu.   

 
 The commands to create these objects can be invoked either here or from buttons on the Tool Bar.  

We will invoke various commands from these toolbar buttons throughout this procedure.  

4. Decide on the categories for which you want automated fields on the fax cover page.  Generally 
speaking, you will want to include information about the Sender and the Recipient.  For each type of 
information, you will want a label in “Static Text” and an “Edit Box” (“Field Text”) into which the 
automated information will go. Information about the sender will be automatically transferred from the 
FaxFinder Client Software Options screen onto the cover page; information about the recipient will 
come to the cover page from the FaxFinder Address Book’s Contact screen or from the FaxFinder 
Send Fax screen (if the Add Recipient button is used to specify the fax recipient); and occasional 
information will come from the FaxFinder Send Fax screen (for the subject of fax and the comment) 
and from the client PC (for the date of the fax).   

To insert an automated field, you must double-click on the “Edit Box” button and then drag open a 
box at the desired place on the screen.  Typically, one would place the label of the category using  
the Static Text icon first and then locate the Edit Box beside it.  (The “Edit Box” button invokes the 
same function as the “Field Text” command in the Insert menu.) 

Static Text Icon  Edit Box or Field Text Icon 
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The FaxFinder supports the automated field types listed in the table below. 

Object Type in 
Template Editor 

Source of Info Placed in 
Field 

Description 

User Name FF Client Add Device Address 
screen 

User Name within FaxFinder system 

From Name FF Client Options screen Sender’s Name 

From Company 
Name 

FF Client Options screen Sender’s Company Name 

From Phone FF Client Options screen Sender’s Voice Phone Number 

From Fax Number FF Client Options screen Sender’s Fax Number 

Destination Name FF Client Contact screen or 
Send Fax screen 

Recipient’s Name 

Destination 
Company Name 

FF Client Contact screen Recipient’s Company (Organization) 
Name 

Destination Phone 
Number 

FF Client Contact screen Recipient’s Voice Phone Number 

Destination Fax 
Number 

FF Client Contact screen or 
Send Fax screen 

Recipient’s Fax Number 

Date client’s PC Date of Fax Transmission 

Subject FF Client Send Fax screen Subject of Fax Message 

Comment FF Client Send Fax screen Comment about Fax Message 

Title not used not used 

Department not used not used 

Address 1 FF Client Contact screen Recipient’s Street Address 

Address 2 not used not used 

City FF Client Contact screen Recipient’s City 

State FF Client Contact screen Recipient’s State/Province/County, etc. 

ZIP Code FF Client Contact screen Recipient’s ZIP code or postal code 

 

5. Select the “Static Text” cursor labeled N and drag to open the desired field.   

To have freedom to move the cursor in a continuous fashion leave the Grid button,  , in 
the unselected position (its darker shade represents its unselected state).  You can also turn the Grid 
on and off in the Settings pull-down menu. 
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6. Enter the field label in the Static Text box.  Be sure to allow enough room for the size of font you have 
chosen.  If the box is too small for the font size, the text will be cut off. 

To select font, the font style, and font size, use the  cursor. 

 You can also access font settings from the Settings dropdown menu. 

To align the text to the left edge, right edge, or center of the box, use the 

 
cursor. 

For example, you might create a static text item of the word “Date.”  To move the box, click on it and 
move it when the 4-direction cursor appears.  To expand or contract the box, click on it and drag an 
edge or a handle until the desired size/shape is achieved. 

 

 

7. Select the “Edit Box” (or “Field Text”) cursor labeled ab and drag to open the desired field. 
Double-click on the box you have opened.  The Properties screen will appear.  Scroll down the list 
and highlight the field type (listed in the “Type” drop-down list) that you want on the cover page.  
There is no need to use the “Title” field.  Click OK. 

You will not type anything in the Edit Box that appears on the screen.  However, be sure to make the 
Edit Box large enough for the font size you have chosen.  If the box is too small for the font size, the 
text will be cut off. 

To follow our example, you would select “Date” to insert a date field next to the “Date” label you have 
previously placed on the page. 
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     You might want the automated field value to be placed on a line or in a rectangle.  If so, you could 
use the line cursor to put a line beneath the edit box or use the rectangle cursor to place a rectangle 
around the edit box.  You can place lines, rectangles, and ellipses on the page for any purpose.  
Rectangles and ellipses can have a solid fill or a shading (called “hilight”).  These graphic functions 
are described in the table below. 

 

Shape Cursors:  
 

  A B C D E   

 

A. Line B. Rectangle C. Ellipse D. Hilight shape E. Fill shape 

Use to draw Use to draw 
rectangles. 

Use to draw 
ellipses. 

Not supported. When selected, 
any rectangle or 
ellipse made will 
have a black fill.  

 

To set the line width for lines, rectangles, and ellipses, use the drop-down box at the far-right of the 
Template Editor’s tool bar.  (You need to have the screen open widely enough to see its entirety.) 
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8. To add a graphic file to the cover page template, click on the Image icon.  
Then browse to the directory that contains the desired graphic file.  Files of type bmp and tif can be 
inserted into cover pages. 

Insert graphics files into your cover page template as needed. 

9. Save the file to the Cover Pages directory in your operating system.  The .cpg file must be saved in 
this location in order for it to be accessible to the FaxFinder client software.  When saved to this 
location, the file name of the customized cover page template you have created will appear in the 
“Cover Page Style” drop-down list on the FaxFinder Send Fax screen. 

10. We advise previewing and printing your custom cover page template using the Multi-Tech Tiff Viewer 
program rather than the Template Editor program. 

 The illustration below shows how the fields specified in the Template Editor program will be filled out 
when the template is used at the FaxFinder Client Send Fax screen.  The Object Types (from the 
Properties screen that appears when you double-click on an Edit Box) for common field types are 
specified. 
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Modifying Existing Cover Page Templates 
Note:  While all five stock cover page styles can be readily customized, the styles 

“PlainComplete” and “PlainShort” are especially well suited to customization.  In most 
cases, one can start with these files and simply add one’s own company name in text or 
insert one’s graphical company logo. 

1. Open the Cover Page Generator program.  Go to Start | Programs | FaxFinder Client Software | 
Cover Page Generator.  You can also open the Cover Page Generator program from the FaxFinder 
Fax Client Software program by opening the Edit menu and selecting “Edit Cover Page Template.” 

 
2. In the File menu, select “Open.”  Browse to the directory into which the FaxFinder client software has 

been installed.  Typically, this will be C:\Program Files \ Multi-Tech Systems \ FaxFinder Client 
Software \ Cover Pages.  Select a cover page template from the list. 

For our example, we will use the cover page template file FaxComplete.cpg. 

3. In the File menu, select “Save As” and rename the file, saving it in the ‘Application Data’ directory for 
the FaxFinder client software (this is a default directory). The default directory will vary for different 
Windows operating systems. (For Windows 2000, this will be C:\Winnt \ Profiles \ <username> \ 
Application Data\ FaxFinder Client Software \ Cover Pages.  For Windows XP, this will be 
C:\Documents and Settings\<username>\Application Data\Fax Finder Client\Cover Pages.)   
In all cases, however, the new cover page template must be saved in the default location in order for 
the FaxFinder Send Fax screen to detect it and make it available for use. 
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For our example, we will rename the file rmc1.cpg, for the purposes of our fictitious company, Rocky 
Mountain Construction, Inc. 

 
4. You can use the Tab key to skip from field to field in the template.  Note, however, that any values 

added to template fields will be overwritten by values specified in the Address Book (in “New Contact” 
screens launched from Edit | Add Contact in the FaxFinder Fax Client Software program). 
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5.  Add company logo at top of cover page. 

For our example, we will add the graphic file “ff-rocky-mtn-logo1.bmp” to the cover page. 

In the Insert menu of the Template Editor, select “Image.” 

 
 

Browse to the location of the graphics file to be used.  Click Open. 

Move the + cursor to the desired location of the graphic.  Then click and drag to size the graphic.  
Click and drag on the cursor dots on the periphery of the image to resize it and set its 
vertical/horizontal aspect ratio. 
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6. Add company slogan to bottom of template.  

For the purposes of our fictitious company, Rocky Mountain Construction, Inc., we will use the slogan 
“Building on New Horizons.” 

Select the “Static Text” cursor labeled N and drag 
to open a text box at the bottom of the template page. 

Enter the slogan. 
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7. In the File menu, select “Save As” and overwrite the file using the same filename used in step 3, 
saving it in the ‘Application Data’ directory for the FaxFinder client software.  (For Windows 
NT4/2000, this will be C:\Winnt \ Profiles \ <username> \ Application Data\ FaxFinder Client Software 
\ Cover Pages.  For Windows XP, this will be C:\Documents and Settings\<username>\Application 
Data\Fax Finder Client\Cover Pages.) 

For our example, we will overwrite the file using the file name rmc1.cpg, which befits the purposes of 
our fictitious company, Rocky Mountain Construction, Inc. 

8. To use your customized template when sending a fax, you must click “Use Cover Page” in the 
FaxFinder Send Fax screen.  Then scroll through the “Cover Page Style” list to find the file name of 
the custom template you have created.  In our example, it is rmc1.   
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9. When the fax is sent, the ‘automated’ fields on the cover page template will be filled in with 
information from the Address Book (if the recipient is listed there).  Click on “Preview Fax” in the 
FaxFinder Send Fax screen to examine the fax with cover page. 
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Cover Page Generator Menu/Icon Command Descriptions 

File Menu 

 
 

FaxFinder Cover Page Generator Software Menu Command Definitions (cont’d) 
Command Name Icon 

 
Shortcut Description 

File Menu commands    

New 
 

Ctrl + N Creates new cover page template file. 

Open 
 

Ctrl + O Opens an existing cover page template file for 
viewing or editing. 

Save 
 

Ctrl + S Saves cover page cpg file at current path. 

Save As -- -- Saves cover page cpg file at new path that user 
specifies. 

Print  
 

Ctrl + P Prints the current cover page template. 

Exit 
 

-- Closes current cover page template file and closes 
program.  User is prompted to save. 
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Edit Menu 

The Undo command (also accessible using the keyboard shortcut Ctrl + 
Z).  

The undo 
button. 

Undo reverses the effect of the last command. 

 

Insert Menu 

 
FaxFinder Cover Page Generator Software Menu Command Definitions (cont’d) 

Command Name Icon Description 
Insert menu commands  

Image 
 

Use to insert a bmp or tif image into the cover page template. 

Field Text  
or 
Edit Box 

 
Use to insert an automated field into the cover page template.  The 
values inserted into automated fields come from FaxFinder Address 
Book, FaxFinder Send Fax screen, from client user’s PC, and from 
the remote fax sender. When you create a new Edit Box, you must 
select it and double-click on it to make the Item ID screen appear.  It 
is in the Item ID screen that you specify which type of information will 
be placed in this position on the fax cover page.  Use icons to align 
text to left, center, or right.  Use “Font” icon or command in Settings 
menu to alter font, font size, and font style. 
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FaxFinder Cover Page Generator Software Menu Command Definitions (cont’d) 
Command Name Icon Description 
Insert menu commands  

Static Text 
 

Use to insert text objects needed in the cover page template.  These 
uses include labels for automated fields (TO, FROM, DATE, etc.) and 
plain text like a company name or slogan. Use icons to align text to 
left, center, or right.  Use “Font” icon or command in Settings menu 
to alter font, font size, and font style. 

Line 
 

Use to insert line objects into the cover page template.  Use Line Size 
drop-down menu at far right of screen to select width of lines. 

Rectangle 
 

Use to insert box objects into the cover page template. Use Line Size 
drop-down menu at far right of screen to select width of lines. 

Ellipse 
 

Use to insert circles or elliptical objects into the cover page template.  
Use Line Size drop-down menu at far right of screen to select width of 
lines. 

Hilite 
 

Not supported. 

Filled Object 
 

When selected, rectangles and ellipses created will have black fill. 

deleting objects -- Use the keyboard Delete key to delete a selected object. 

Line Size dropdown 
menu 

 Use to select line widths for line objects, rectangle objects, and 
ellipse objects. 
This icon is located at the far right on the screen. You may need to 
open the program to “Full Screen” view to see this drop-down menu. 

 

View Menu 

 

FaxFinder Cover Page Generator Software Menu Command Definitions (cont’d) 
Command Name Icon Description 

View Menu commands  
Zoom In 

 
Use to view a smaller area of the cover page 
template file in greater magnification.   

Zoom Out 
 

Use to view a larger area of the cover page 
template file in a lesser magnification. 

Fit to Width -- Use to get magnification of file such that its 
horizontal dimension fits proportionally into the 
window. 

Fit in Window -- Use to get magnification of file such that the 
entire cover page template fits proportionally into 
the window. 

Toolbar -- Use to show or hide toolbar of command icons. 
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Settings Menu 

 
 

FaxFinder Cover Page Generator Software Menu Command Definitions (cont’d) 
Command Name Icon Description 

Settings Menu commands  
Font 

 
Brings up Font dialog box in which font, font size, and font style can 
be set. 

Grid 
 

Use to turn grid on and off.  If grid is off, objects can be positioned in 
cover page in a continuous fashion.  If grid is on, objects can only be 
positioned at discrete grid coordinates. 

 

 

 

Reporting Failed Faxes to the Administrator  

Occasionally clients will receive email messages from the FaxFinder that pertain to faxes that have failed 
partially or entirely.  That is, some or all of the intended pages of the fax may arrive in a form that cannot 
be read.  Here is the sequence of events you may encounter and the proper response. 

1. The client user receives an email message from the FaxFinder about a partially or wholly failed fax sent 
to him/her.  

2. Advise the sender of the fax to re-send all or part of the fax.  

3. If the fax was only partially a failure, then TIFF/PDF files for the successful pages will be attached.  If 
any pages of the fax failed, then an additional file will be attached to the email message.  It will have a 
name like modem0modem1_date-time.txt.  This is the modem log file. 

4. The modem log file contains information about the “conversation” between the sending modem and the 
FaxFinder’s receiving modem.  This information may be valuable to the FaxFinder administrator in 
protecting the fax system and preventing future errors. 

5. The client user should forward the modem log file to the FaxFinder administrator in an email message.  
The FaxFinder administrator’s email address should be viewable in any fax you have received via the 
FaxFinder. 
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Multi-Tech Warranty Statement 
Multi-Tech Systems, Inc., (hereafter “MTS”) warrants that its products will be free from defects in material 
or workmanship for a period of two, five, or ten years (depending on model) from date of purchase, or if 
proof of purchase is not provided, two, five, or ten years (depending on model) from date of shipment.  
MTS MAKES NO OTHER WARRANTY, EXPRESS OR IMPLIED, AND ALL IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE HEREBY DISCLAIMED.  
This warranty does not apply to any products which have been damaged by lightning storms, water, or 
power surges or which have been neglected, altered, abused, used for a purpose other than the one for 
which they were manufactured, repaired by Customer or any party without MTS’s written authorization, or 
used in any manner inconsistent with MTS’s instructions.  
MTS’s entire obligation under this warranty shall be limited (at MTS’s option) to repair or replacement of 
any products which prove to be defective within the warranty period or, at MTS’s option, issuance of a 
refund of the purchase price. Defective products must be returned by Customer to MTS’s factory — 
transportation prepaid.  
MTS WILL NOT BE LIABLE FOR CONSEQUENTIAL DAMAGES, AND UNDER NO CIRCUMSTANCES 
WILL ITS LIABILITY EXCEED THE PRICE FOR DEFECTIVE PRODUCTS.  

Repair Procedures for U.S. and Canadian Customers 
In the event that service is required, products may be shipped, freight prepaid, to our Mounds View, 
Minnesota factory:  
Multi-Tech Systems, Inc.  
2205 Woodale Drive  
Mounds View, MN 55112  
Attn: Repairs, Serial # ____________  
 
A Returned Materials Authorization (RMA) is not required. Return shipping charges (surface) will be paid 
by MTS to destinations in U.S. and Canada. 
Please include, inside the shipping box, a description of the problem, a return shipping address (must 
have street address, not P.O. Box), and your telephone number.  If the product is out of warranty, 
payment in advance is required.  Acceptable means of payment include credit card, wire transfer, or a 
check in U.S. dollars drawn on a U.S. bank.  
For out of warranty repair charges, go to COMPANY/Policies/warranty/ . 

Extended two-year overnight replacement service agreements are available for selected products. Please 
call MTS customer service at (888) 288-5470 or visit our web site at 
/PARTNERS/Programs/overnight_replacement/ for details on rates and coverages.  
Please direct your questions regarding technical matters, product configuration, verification that the 
product is defective, etc., to our Technical Support department at (800) 972-2439 or email 
support@multitech.com. Please direct your questions regarding repair expediting, receiving, shipping, 
billing, etc., to our Repair Accounting department at (800) 328-9717 or (763) 717-5631, or email 
mtsrepair@multitech.com.  
Repairs for damages caused by lightning storms, water, power surges, incorrect installation, physical 
abuse, or user-caused damages are billed on a time-plus-materials basis.  
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Repair Procedures for International Customers (Outside U.S.A. and Canada)  

Your original point-of-purchase Reseller may offer the quickest and most economical repair option for 
your Multi-Tech product. You may also contact any Multi-Tech sales office for information about the 
nearest distributor or other repair service for your Multi-Tech product. The Multi-Tech sales office 
directory is available at www.multitech.com/PARTNERS/Channels/offices/  

In the event that factory service is required, products may be shipped, freight prepaid to our Mounds 
View, Minnesota factory. Recommended international shipment methods are via Federal Express, UPS or 
DHL courier services, or by airmail parcel post; shipments made by any other method will be refused. 
Please include, inside the shipping box, a description of the problem, a return shipping address (must 
have street address, not P.O. Box), and your telephone number. If the product is out of warranty, a 
payment in advance is required. Acceptable means of payment include credit card, wire transfer or a 
check in U.S. dollars drawn on a U.S. Bank. Repaired units shall be shipped freight collect, unless other 
arrangements are made in advance.  

Please direct your questions regarding technical matters, product configuration, verification that the 
product is defective, etc., to our Technical Support department nearest you or email 
support@multitech.com. When calling the U.S., please direct your questions regarding repair expediting, 
receiving, shipping, billing, etc., to our Repair Accounting department at +(763) 717-5631 in the U.S.A., or 
email mtsrepair@multitech.com.  

Repairs for damages caused by lightning storms, water, power surges, incorrect installation, physical 
abuse, or user-caused damages are billed on a time-plus-materials basis.  

Repair Procedures for International Distributors  

International distributors should contact their MTS International sales representative for information about 
the repair of Multi-Tech product(s).  

Please direct your questions regarding technical matters, product configuration, verification that the 
product is defective, etc., to our International Technical Support department at +(763)717-5863. When 
calling the U.S., please direct your questions regarding repair expediting, receiving, shipping, billing, etc., 
to our Repair Accounting department at +(763) 717-5631 in the U.S.A. or email mtsrepair@multitech.com. 

Repairs for damages caused by lightning storms, water, power surges, incorrect installation, physical 
abuse, or user-caused damages are billed on a time-plus-materials basis.  
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